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Chapter 1

What’s New in
Adobe Photoshop CS2

hotoshop CS2 offers major new features that
will truly be of benefit to photographers
everywhere. This first chapter offers a quick
guide to all the new major features that will be
of interest to photographers. Let’s start with the technical
requirements: if you are a Macintosh user, Photoshop CS2
will only run using Mac OS X 10.2.8 or 10.3.0 through
10.3.4 (10.3.4 is recommended), and only a G3, G4 or
G5 computer. If you are using a PC, you will need to use
Windows 2000 (with Service Pack 3) or Windows XP
operating systems running on an Intel Pentium class III or
4 processor. AMD processors are also compatible.
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More than images

The Bridge program is a central
component of the CS2 Adobe Creative
Suite. It is designed so as to provide a
navigational link between the separate
CS2 programs (although you can use it

to launch documents that were created in
other applications as well). But Bridge is
primarily a very useful image management
tool for photographers.

Bridge automation

The Tools menu contains all the Automate
commands that were previously in the File
Browser. Photoshop automation tasks,
such as building a Web Photo Gallery,

can all be done directly from Bridge.

And the Batch Rename feature has been
improved to accommodate the requests of
photographers who need to include things
like the original filename into the renaming
scheme. Plus it has the potential to restore
the original filenames as well.

Scripts are also accessible from
Bridge, so that you can automate images
directly from the Bridge program. Simple
scripts for open and save routines will
make batch actions easier to create and run
(see page 17).

Bridge: The new file browser

It may seem ironic, but the number one new feature in
Photoshop CS2 is not what has been added, but rather what
has been removed from the program. I am talking about the
separation of the File Browser from Photoshop to become
Adobe Bridge, which is a cross-application navigational
program.

So why is this a good thing? Well, there are several
reasons why Adobe did this. Firstly, the File Browser
has always been a processor-hogging application within
Photoshop itself and that was not a good state of affairs
when you had the File Browser wanting to catalog and
cache a whole bunch of files while you, the user, were
wanting to get on with serious Photoshop work. Adobe
Bridge is a central application that can be shared by all
the Adobe Creative Suite applications. Bridge has its own
menu options and keyboard shortcuts, making Bridge
automation and navigation easier. These overall benefits
can mean less disruption to your Photoshop workflow.

The Bridge interface is coming ever closer to matching
the way we edit pictures on a light box. Bridge has
several work space layout presets that you can customize
according to your own way of working. You can also have
multiple windows of Bridge open at once and this will
enable you to view the contents of more than one folder at
a time and each can be compacted to make these window
views more manageable on the screen. And the folder
management is made easier because you can drag and
drop folders within Bridge just like you can in the System
Finder/Explorer.

The thumbnails in the content area can be dynamically
scaled in size and there is a choice of several layouts for
presenting the image and document information. The
Slideshow feature (see Figure 1.2) provides a nice clear
viewing environment that can be configured to fill the
whole screen or display a slideshow in its own window.
And this comes complete with a set of basic editing
controls for marking the images you like best. The overall
rating system in Bridge is certainly more extensive, but



also a lot simpler to utilize. You can use a EJED CDED
command to cumulatively add a star rating to an image
and use EJED ED@ to cumulatively remove stars. This
rating system makes it easier to concentrate more fully on
making your image selections, plus you can apply color
labels, which is a further aid to classifying and grouping
images in Bridge.
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Figure 1.1 The File Browser has now become a separate application, called Bridge. The method of accessing the images remains

unchanged. All you have to do is click the ‘Launch Bridge’ button (circled) in the Photoshop CS2 options bar to open the Bridge
window interface shown here. Once Bridge is open you can perform all the usual File Browser type functions, but with added new

features such as the ability to dynamically set the zoom size of the thumbnails, apply preset Bridge work space and thumbnail display

configurations, including Filmstrip and Slideshow display modes.
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Figure 1.2 The new Bridge program includes a wonderful new slideshow viewer mode that will display images to fill the entire
screen area. Once you have learnt the simple shortcut controls, it makes the reviewing and picture selection process a doddle.

Digital Negative (DNG) format

In September 2004, Adobe announced

the introduction of the new Digital
Negative (DNG) file format. This offers a
new industry standard for the storage of
raw camera data and the DNG raw data
converter program is available for free
download from the Adobe website. Support
is now growing, and other applications
such as Capture One, iView Media Pro and
Extensis Portfolio all now support DNG.
Any file that has been converted to the
DNG format will be recognized in this and
the last version of Photoshop CS and you
can also now save files out of Camera Raw
using the DNG file format.

Camera Raw

Camera Raw file processing is improved with a new
updated version of the Camera Raw plug-in that now
supports over 70 digital cameras. The Camera Raw 3.0
plug-in is configured by default to make automatic image
adjustments that optimize your images until you decide
to override these settings manually or apply a preset
setting. Batch processing is easier and more logical, plus
you can make extra editing decisions in Camera Raw
such as straighten an image or apply a crop (which is not
permanent and can be re-edited) and save multiple versions
using the new Digital Negative (DNG) file format.

When you make a multiple selection of raw image
thumbnails in Bridge and open them, you now get to see
a single Camera Raw interface with a strip of thumbnails
to the left (see Figure 1.3). This new interface makes it
easier to manage batches of images. When multiple raw



images are viewed via the Camera Raw dialog, Camera
Raw builds a temporary cache of large previews for all the
selected images, and these will allow you to use Camera
Raw as a browser type interface in which you can review
images in close-up detail, navigate from one image to the
next at a synchronized zoom level and make important edit
decisions, such as apply ratings to the selected images,
the same way as you would in Bridge. You can manage
the image processing by synchronizing the Camera Raw
settings across selected images based on the first selected
image and once you are finished editing in Camera Raw,
have those files process in the background by choosing
Done to update the image settings or click Save... to save
to a specific destination.

What’s new in Adobe Photoshop CS2

Camera Raw opening

The Camera Raw plug-in will allow you

to open your raw images in Bridge or
directly in Photoshop. For example, the
EIE) EDEGD shorteut will display the
Camera Raw plug-in (shown below) via
the Bridge program. This method frees up
Photoshop to carry out other tasks. If you
simply double-click an image or selection
of images, the plug-in will be hosted by
Photoshop. But you can set the preferences
in Bridge so that double-clicking will open
the Camera Raw plug-in via Bridge instead.
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Figure 1.3 Camera Raw supports the processing of multiple images and their rating and also allows synchronization of a series of edits.



Martin Evening

Adobe Photoshop CS2 for Photographers
www.photoshopforphotographers.com

Everything in perspective

As well as using the clone stamp tool in
normal or healing mode, you can copy
and paste image content and have it
placed in perspective by dragging and
dropping selections within the image
itself. Vanishing Point also allows you to
describe additional planes within the image
and copy different planes of perspective.
You can actually drag objects around
corners from one plane to another!

Figure 1.4 In the example shown here | used
the create plane tool to position four points on
the image to describe the perspective of the
deck in this picture. | was then able to drag the
sidebar handles outwards to incorporate more
of the deck area. Once | had described the plane
of perspective, | then selected the clone stamp
tool and used this to sample the deck texture

in the middle of the picture and clone this to
the corners of the photograph, matching the
perspective in the rest of the picture.

Vanishing Point

The Vanishing Point feature lets you retouch images in true
perspective. Inside the modal dialog you can create a plane
grid based on key perspective points in the picture. Once this
is done you can clone, heal, paint and place image contents
so that they match the perspective of the image.
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Image warping

The image Warp command allows you to distort an image
layer directly in Photoshop using handle controls. It
differs from the Liquify filter in that the Warp command
is actually a new type of Transform command that can

be used to warp image pixels, pen paths and selections.

If you ever complained about the lack of a decent Shear
filter in Photoshop, well this is it! When editing a pixel
image or image layer, a Warp or Transform command will
permanently edit those pixels, transforming them into a
new shape. The new Smart Objects feature, which we will
be looking at next, now provides you with a non-destructive
way of using the Transform and Warp command.

Figure 1.5 The new CS2 Warp command is an extension of the Transform
command in Photoshop. To warp images, choose Edit = Transform = Warp.
The Options bar will change to reveal the Warp options, that include a pop-up
list of Warp effects. These are similar to the existing Type text Warp effects. You
can vary these warp distortions by adjusting the sliders in the Options bar or
mouse-dragging within the bounding box area segments. The most useful of
these Warp effects is the Custom option that allows you to apply a freeform warp.
In the example shown here, | was able to use a Custom warp to add curvature
and perspective to a new photograph placed on the page of a book and match the
curvature of the page.
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Placing raw files as Smart Objects
You can even place a Camera Raw file as
a Smart Object or multiple Smart Object
layers within a Photoshop CS2 document
and keep the raw adjustments editable.
This technique can be useful if you wish
to combine different interpretations of a
master raw file, keeping them on separate
layers with layer masks.
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Smart Objects

This feature is not quite the answer to filter layers, but it

is getting close. Smart Objects provide a mechanism in
Photoshop for non-destructive pixel adjustment layers. Smart
Objects in Photoshop CS2 follow the same logic as those

in GoLive. When you promote a layer or group of layers to
become a Smart Object, the original pixels are preserved as
a separate set of layers within the document. You can apply
unlimited transforms or warps to Smart Objects (as shown
below) without ever degrading the original pixels. This
means that you can scale a Smart Object layer to make it
smaller and then bigger again without degrading the image
layer any more than is necessary. And you can also duplicate
a Smart Object as many times as you like so that whenever
you update one layer, you update them all.

Figure 1.6 When you promote a layer or group of layers to become a Smart
Object, the layer data contents are stored separately within the image file as a
document within a document. The advantage of this is that you can transform or
warp a Smart Object any way you like. Each time you transfer a Smart Object layer,
the original pixels are referenced, which means there is no cumulative pixel loss.
So, for example, in the example shown here, you scale a Smart Object down in size
and then decide to enlarge it again or transform it in some other way. The Smart
Object contents can also be edited independently. The Smart Object contents for
the flower layer are shown on the left.



32-bit support and Merge to HDR
Photoshop CS2 is enabled for High Dynamic Range (HDR)
imaging. This is all fairly new still but it is anticipated that
in the not too distant future, more digital cameras will boast
HDR capability and be able to capture a high dynamic
range scene within a single image and store it as an HDR
type file. HDR has many applications within special effects
work and 3D modeling. For photographers though it offers
you a means to capture all the luminance information in a
bright daylight scene and decide later which exposure or
tonal compression works best.

We now have the Merge to HDR feature that will enable
you to combine multiple digital exposures to create a 32-
bit per channel HDR image. Photoshop CS2 provides an
HDR conversion dialog for when you wish to convert these
HDR files to a normal 8-bit or 16-bit per channel image in
Photoshop. You have at your disposal four different conversion
methods, of which the Exposure and Gamma and the Local
Adaptation are probably the most easy to work with.

HDR Conversion
Method: | Local Adagtation #
Radius: 8 px
N
Threshold: los

o

[a] Tening Curve and Histogram

.i% | Comner

|% Output; |57

Input: |66

Figure 1.8 The HDR conversion dialog is displayed whenever you change the
bit depth from 32-bit per channel to either 8-bit or 16-bit per channel mode. The
HDR Conversion dialog provides four different conversion methods for rendering
the high dynamic range image data as a normal low dynamic range image.

What’s new in Adobe Photoshop CS2

Figure 1.7 Atypical daylight scene such

as the one shown here will require different
exposures depending on whether you wish

to expose to capture the shadow detail in the
foreground, the highlight detail in the sky and
the hills in the distance or somewhere between
these two extremes. Merge to HDR will let you
combine multiple bracketed exposures, register
the images and blend them into a single High
Dynamic Range image in 32-bit mode which
can then be rendered as a normal 8-bit or
16-bit image. This two-step process provides
a mechanism for greatly extending the dynamic
exposure range of your digital camera.
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Chromatic aberration and vignetting
Photoshop CS2 will now let you correct
the chromatic aberration color fringeing
and vignetting in any image file, not just
the raw image files that are processed

using Camera Raw.

Lens Correction

If you spend good money buying the best lenses for your
camera system then you shouldn’t encounter too many
problems with the optics. But most of the digital cameras
on the market these days, and especially the small compact
cameras, have fairly basic lenses and these are prone to
problems such as barrel lens distortion at the widest angle
setting and pincushioning when you zoom in close. The
Lens Correction filter provides a comprehensive set of lens
distortion correction tools that can be used to great effect to
correct the curvature in a photograph caused by using a less
than perfect lens.
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Figure 1.9 The poor lens performance you get with some cameras can be vastly improved with the new Lens Correction filter. As
is shown in the above example, you can correct for both the curvature and planar distortion. Also included are the Vignetting and
Chromatic Aberration controls that were previously found only in the Camera Raw dialog.
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Noise reduction

The new Reduce Noise filter uses a smart method of

noise reduction that can get rid of unwanted noise without
destroying edge detail in a picture. The Reduce Noise filter
is also able to treat images with heavy JPEG artifacts and
smooth out the square block patterns that you sometimes
see. It can even be used to much improve the appearance
of GIF images in Indexed Color mode (but you do have to
convert them to RGB mode first).

More 16-bit capability

What’s new in Adobe Photoshop CS2

Photoshop CS2 has extended the support
for some of its filters such as the Liquify
filter, so that they are now able to work in

16-bit per channel mode.
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Figure 1.10 Grainy pictures like this can be cleaned up with the help of the Reduce Noise filter. In the Advanced mode you can filter

out the noise on a per channel basis.
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Smart Sharpen
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Figure 1.11 The Smart Sharpen filter dialog provides improved sharpening controls with an easy-to-use interface.

Smart Sharpen

The Smart Sharpen filter has a nice, simplified interface
and provides a less destructive form of image sharpening,
enabling better edge detection and producing fewer
haloes. In Advanced mode the Smart Sharpen filter offers
additional controls that allow you to selectively sharpen
the shadows and highlights and you can also save and load
Smart Sharpen settings. The other interesting feature is the
added ability to counteract certain types of image blurring.
It offers improved optical lens blur correction and a limited
ability to correct for motion blurring as well.

Blur filters

Three new blur filters have been added to Photoshop CS2.
The first is Box Blur, which applies a square type blur

to an image instead of a circular type blur. The Surface
Blur is like a blur filter that blurs an image based on the
tonal levels. The Radius controls the blur radius amount
while the Threshold control governs the range of tones to

12



which the blur is applied. The result is in some ways like a
diffusion type filter and can be useful for removing image
grain and noise from a photograph. The other new blur
filter is the Shape Blur. This filter is like an extension of
the Box Blur and allows you to select a blur shape from the
preset list shown in the dialog. You can add or replace more
shape presets via the fly-out menu, the same way as you
can with other shape presets.

BoxBlur

Surface Blur
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Figure 1.12 Here are the three new blur filters. On the left, the Box Blur filter.

In the middle, the Surface Blur filter. And on the right, the Shape Blur filter. These
three filters have all been applied to the same image of a night-time scene in order
to provide the best comparison.

Red eye removal

The color replacement brush in Photoshop CS was never
particularly successful at the task of removing red eye from
images. The red eye tool is new to Photoshop CS2 and uses
an improved algorithm for removing red eye from flash
portrait photographs. It is fairly simple to work with. All
you have to do is select the right options for the Pupil size
and darken amount from the Tool Options bar and then
click inside the red eye pupil.

Figure 1.13 There are limits as to how good you can make someone look using
Photoshop, but with the new red eye removal tool all you have to do is click inside
the eye to remove the red eye effect completely.

Halftone interference patterns

The Box Blur filter can provide a useful
alternative to the use of the Median and
Gaussian Blur filters for the removal of
interference patterns from scanned halftone
images.
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Figure 1.14 The spot healing brush tool
options. In general, the spot healing brush is
just as effective as the normal healing brush,
providing there is enough usable source data
surrounding the blemish you wish to repair.

Image window tiling

The Window = Arrange menu now allows
you to manually choose whether to tile
images vertically or horizontally.

Scroll wheel and pen stylus hehavior
If the mouse or pen stylus you use features
a scroll wheel then you can use the scroll
wheel to quickly zoom in and out of an
image, centered around the position of

the cursor. If you are using a pressure
sensitive pen such as a Wacom, the brush
attributes can be linked to pen barrel
rotation movements.

T Futura

T Gadget

O Adobe Garamond Pro
H Geeza Pro
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T Georgia
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@ Gill Sans (TT)

T Gill Sans

T Helverica Neue
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T Hoefler Text

W Humana Serif ITCTT
W Humana Sesif Md ITC TT

Figure 1.15 Photoshop CS2 features a
WYSIWYG font menu display listing which will
appear whenever you select a new typeface from
the Type tool Options bar.
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Spot healing brush

The spot healing brush works in a similar way to the normal
healing brush except you don’t have to use first to
define a source sample point. All you have to do is simply
click on or paint over the marks you wish to remove. The
spot healing brush works so well in Photoshop CS2, it can
often be used in place of the normal healing brush.

Interface and performance

Photoshop CS2 performance has been enhanced through
auto optimized tiling to provide improved image cache
management and an overhaul of the big data management.
If you use Windows, you will notice that image documents
are no longer restricted to the application window. This
will make it possible for Windows users to take full
advantage of a dual display setup when using Photoshop.

Menu font size

The latest LCD displays are getting bigger and as the pixel
resolution size of the displays increase, the palette sizes are
becoming relatively smaller. I am fortunate enough to own
a large 30 inch LCD display which is great for viewing
images big on the screen, but the downside is that the font
size in all the dialogs can be tiny to read from a normal
viewing distance. The General preferences will let you
increase the small font sizes to make smaller text items
easier to read.

Menu customization

The Keyboard Shortcuts option in the Edit menu has

been updated to provide more options for customizing the
Photoshop CS2 interface. As the number of features in
Photoshop has grown over the years, all the menu choices
can be simply overwhelming. This is especially true if you
are new to the Photoshop program. The new Customize
feature is like a ‘make simpler’ command. You can edit
the shortcuts as before, but also choose to hide those



menu options you never use and apply color coding to
make more prominent the menu items you use most often.
Photoshop CS2 ships with menu customization presets
such as a What’s New in Photoshop CS2 preset. The
philosophy behind the use of this feature is: ‘everything
you do want with nothing you don’t want’!

Image Layer Select lﬂm View Window Help

ast Filter HF
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- Vanishing Point...  #V
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. Moise > Box Blur... |
| Pixelate » | Gaussian Blur... |
Render > Lens Blur...
 Sharpen > Motion Blur...
Sketch > Radial Blur...
Stylize > Shape Blur...
Texture > Smart Blur...
Video > Surface Blur...
Other > p—
Digimarc »

Figure 1.17 The Photoshop menus can be customized by going to the Window
= Workspace menu. In the example shown here, | chose the What's New in
Photoshop CS2 menu work space. This menu work space setting will highlight all
the new Photoshop CS2 features in blue.

Memory access limits increased

The advent of modern operating systems running on
64-bit processor computers has brought expectations of
Photoshop being able to run using more RAM memory. To
date, the most RAM you could allocate to Photoshop was
2GB. And if you are running Windows 2000 or a regular
version of Windows XP, you can still only allocate up to
2GB. But if you are using a G5, a 64-bit AMD or 64-bit
Intel processor, that figure has now been increased. For a
Mac running OS X 10.3 or higher, you can now allocate
up to 4GB (less whatever the operating system frameworks
take up, so effectively up to 3.5 GB). If you are running
Windows XP 64-bit edition you can allocate 4GB (minus a
very small amount for the operating system).

What’s new in Adobe Photoshop CS2
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Click and drag to move layer or selection
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Figure 1.16 The Info palette is customizable
so that you can have all these status items such
as the document profile space, scratch disk size
and so on, displayed at once in this palette.
Macintosh users will now get to see tool hints
shown here as well. These change according

to the keys you have held down to indicate
extra available options. These tool tips are
particularly useful for Photoshop newcomers.

Save Workspace
| Name: [Workspace-standard |  Ssave )
Capture (_cancel ) |
E Palette Locations
™ Keybeard Sherteuts
# Menus

Figure 1.18 The new Save Workspace
options allow you to save complete work space
settings that include not just the palette layouts
but the custom menu settings as well.
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Figure 1.19 The new Layers palette design.
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Figure 1.20 The Align Layers to Selection
Layer menu option lets you make a selection
and instruct Photoshop to align the linked
layers to the border sides or center of that
selection.

Client: Rainbow Room. Model: Jasmin @ Nevs.

16

Changes to the Layers palette

The Layer linking column has been removed from the
Layers palette and linking is now done via a link button
at the bottom. Now some people will doubtlessly be up
in arms over these changes. Yes, it does take some getting
used to, but ultimately, the layer selection and linking has
really been made more simple.

Contiguous layers can be selected by clicking on
the layer names. Discontiguous layer selections are made
by clicking on layer names to add to or subtract
from a layer selection (but you can still load the non-
transparent contents of a layer as a selection by
clicking on the layer image icon). Layer groups can now
be selected (and then linked) by dragging over the
image with the move tool (or just marquee-drag if the Auto
Select option is checked).

Layer masks can be moved by dragging them from
one layer to another and you can also copy layer masks
by dragging them within the Layers palette.

Figure 1.21 The View menu options include Show Layer Edges which means
that the currently selected layer or layers will be indicated with a rectangular color
edge border. The Smart Guides option is useful as a visual aid for aligning layer
elements. The Smart Guides (shown here in pink) will flash on and off to indicate
when a layer element is aligned to other layers in the image.



Automation

Along with the interface refinements and better
optimization, several improvements have been made to the
automation features in Photoshop, which are designed to
make Photoshop run faster automatically and provide more
opportunity for users to write their own customized batch
processing routines.

Scripting additions

Scripts are similar to Photoshop actions but they operate
at the operating system level instead of at the application
level only. Scripts are not new. They have been available
for use in previous versions of Photoshop, but there is
more emphasis now on making them easier to implement
and this will encourage anyone who has the know-how to
design their own scripts for others to use in Photoshop.

A good example of the power of scripting is the Image
Processor script (see Figure 1.22). This will forever be
known to me as Russell Brown’s, sorry, Dr. Brown’s Image
Processor. But sadly, there is no place for such frivolous
naming in the sober world of Adobe Systems!

The Script Events Manager lets you combine multiple
scripts in a sequence, combine these with Actions in
Photoshop and attach these to specific Photoshop events.
For example, you could set up a script event where
Photoshop automatically generated a low resolution JPEG
version every time you saved an image out as a Photoshop
format document. The potential is there to create preset
image processing routines for the batch handling of files,
taking source image files and processing them out to
designated folders. This will go beyond what you can do
with Actions alone. And with the Image Processor, you can
create scripts to perform multiple tasks at once.

What’s new in Adobe Photoshop CS2
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Figure 1.22 The new Image Processor.
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Figure 1.23 The Script Events Manager.

Metaframer script

For a good example of what scripting

can do in Photoshop, look out for the
Metaframer script, which will be available
to download from Russell Brown’s
website: www.russellbrown.com. The
Metaframer script will enable you to
automate taking specific metadata from
your image files (such as copyright credit
information) and adding this information
to the border of an image.
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Adobe Help Center

The new Adobe Help Center enables
registered Adobe customers to conduct
improved searches and access support for
all their Adobe products from Adobe and
third parties. The new database is also able
to provide related links to word searches.
This makes the Help Center more useful
for beginners who may be unfamiliar

with some of the terminology used in
Photoshop.

Animation in Photoshop

This is not a new feature but rather
something that used to be in ImageReady
only. Itis yet another indication that
Photoshop and ImageReady will become
merged at some stage in the future.

This is also further reason for having
Photoshop menu optimization. With
menu optimization different users can
be satisfied more easily by setting up
Photoshop to display only the tools they
most need.

Figure 1.25 The Animation palette.
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Web Photo Gallery

Several new templates have been added to the Web Photo
Gallery, some of which are Flash-based. Web Photo Galleries
can be created directly from selected images in Bridge, but
unfortunately there is still no mechanism for producing
sRGB converted JPEGs from the master images, or utilizing
the cached JPEG preview data. But the Web Photo Gallery
still remains a cool and important Photoshop feature.
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Figure 1.24 The Web Photo Gallery features several new template designs
including several that use Macromedia Flash. The web gallery shown here was
created using the Flash 2 gallery template.



Print with Preview dialog

The print options have long been a source of confusion

due to the contradicting settings options and different print
flow behaviors that exist. The problem has essentially been
linked to the constraints of the various operating systems
and the print interfaces supplied by the print manufacturers.
But Adobe have done their best to help ease the pain by
making a few small changes to the front-end Print with
Preview dialog box so that users will find it easier to select
the correct options at this stage in the print process.

PDF saving

The Photoshop PDF format save dialog has been
significantly updated in order to provide a consistent
approach to PDF creation across all the programs in the
Adobe Creative Suite, where all Suite applications will now
share the same dialog. The Preserve Photoshop Editing
Capabilities checkbox will enable you to preserve all the
image components such as layers and adjustment layers,
just the same as if you had saved an image as a Photoshop
or TIFF format file.

: juisloba EOE Expart;
Adobe POF Preset: | T!

Standard: | None ™ c [ Acrobat 5 (POF 1.4) %] ‘
| T |
{Seatnl General
| |Comoression
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Security !
|
| |Summary
| Options
[ Preserve Photoshop Editing Capabilities
[ Embed Page Thumbnails
[ Dptimize for Fast Web Preview |
| [ View PDF After Saving |
Fonts |
Subset fonts when percent of characters used is less than: |1% |
|
|
|
! ( Save Preset... ) (Esave PR ( Cancel )

Figure 1.26 The new PDF save dialog.
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Print simulation

Professional photographers like having
the ability to simulate the conditions of the
print press on their desktop inkjet printers.
This was possible to do before, but it
required careful configuration of the Print
with Preview color management settings.
the new Print with Preview dialog contains
a menu option in which you can select

the apprropriate print space to simulate
and then all you have to do is click on the
Simulate Paper White and Simulate Black
ink buttons.

FireWire out

This is a video editing feature. It enables
you to send a still image to preview on

a video device via a FireWire connection
and see a preview of how an image in
Photoshop will then appear on a given
video device. To use this feature you need
to have a video device such as the input on
a TV monitor connected to the computer
via a FireWire cable and then in Photoshop
select File = Export = FireWire...
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Overall impressions

Photoshop CS2 is in many respects a most notable
upgrade. There are a lot of features in this version to
satisfy photographers, especially if you shoot digitally.

The separation of the Bridge browser program has freed up
Photoshop to allow Photoshop to run more efficiently and
the added controls in Bridge should be greatly appreciated
since it now makes the picture selection editing faster and
easier.

The Warp Transform and Lens Correction filter make
a welcome addition and the introduction of Smart Objects
has opened up new ways to work with the Warp feature
and the existing Transform commands as well as hinting at
more extensive developments in the future for this feature.
The 32-bit editing capability may be a little ahead of its
time, but we now have the capability to create HDR images
from a standard digital camera and convert these using
Merge to HDR to produce fine detail in the shadows and
highlights like never before.

The ability to customize the interface and the extra
automation features such as improved scripting ability
are also important if you are looking to streamline the
Photoshop interface and speed up the processing of
repetitive tasks beyond the limits of what you can do using
Actions alone.

This upgrade to the Photoshop program is one of the
most significant updates I have seen in all the years I have
been writing about Photoshop. It gets a definite thumbs up
for providing a well-thought out response to the needs of
busy photographers.



Adobe Photoshop CS2 for Photographers
This review of Adobe Photoshop CS2 is an extract from
Martin Evening’s forthcoming book: Adobe Photoshop
CS2 for Photographers, which will go on sale from late
May 2005. This latest update in the Adobe Photoshop for
Photographers series will contain 704 pages in full color,
plus a CD with over 120 minutes of video tutorials, and a
30 page guide to shortcuts in Photoshop CS2 and Bridge.
The book contains even more information and updated
advice on everything you need to know about using
Photoshop, from digital capture to print output, as well as
all that is new in Adobe Photoshop CS2!

To order the book

Adobe Photoshop CS2 for Photographers is published by
Focal Press, an imprint of Harcourt Education. The title
will be stocked in most major bookstores throughout the
UK and US and via many resellers worldwide. It will also
be available for purchase from: www.focalpress.com and
also through the on-line bookstores: www.amazon.com and
www.amazon.co.uk.
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